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Background

More than 1/4 of land in the United States is impacted by ranching activities and in 

Texas, >70% of land is considered ranch land. Thus, in Texas it imperative for 

conservationists and ranchers to work collaboratively to turn working lands into 

agroecological restoration spaces where biodiversity and business can coexist 

(USDA 2019). Very little intact native prairie habitat (<1% Blackland Prairie) remains in 
North Texas and working rangelands in this region are incredibly important potential conservation spaces for 

the Fort Worth and Blackland Prairie ecosystems (NPAT 2022). Intact Fort Worth Prairie, historically home to 

hundreds of species, is now one of the rarest ecosystems in the US, with a G1/G2 ranking, meaning it is 

critically imperiled with only 6-20 known occurrences today (GPRC 2023). While small scale prairie 

restoration projects and campaigns have successfully restored several prairie preserves in the region, 

questions remain whether these approaches can be pursued at scale and how historic ecological dynamics, 

i.e. grazing by large ungulates and wildfire, will be simulated and maintained in these habitats long-term.

Restoration on working lands, and more specifically the conversion of ranchlands to agroecological 

systems, when managed through sustainable grazing and restoration practices, can have substantial, large 

scale conservation impacts. Working pastures can also be home to hundreds of native plant species that are 

critical habitat for pollinators and wildlife, can create corridors for migratory species, and sustain innumerable 

critical ecosystem services (Dass et al. 2018). Prescribed grazing methods prevent overgrazing of plant 

communities that grow in pastures through rest-rotation cycles, allowing prairie plant communities to recover 

and sustain climax species assemblages. While not new, prescribed, rotational grazing practices are not 

widely utilized due to their perceived complexity and a lack of data to showcase their conservation and 

economic benefits. By recovering working lands’ native plant assemblages and ecological function, not only 

do these lands become beneficial habitat, they transmit economic sustainability to ranching operations,

More than

1/4
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Background

making them more resilient to climate and market fluctuations, protecting 

businesses and guaranteeing land management into the future. 

For the purposes of conservation, these prescribed grazing practices 

need to be informed by the ecology of the species that ranchers are 

attempting to restore and conserve. Ranchers will need annual data 

conveying the composition and diversity of plant communities in their 

pastures, as well as regular temporal observations of what plant species are 

present when and more specifically the phenology of these species, i.e. 

when they are flowering and going to seed to ensure their return each year. 

Such observations are time consuming and an impractical undertaking to 

ask of a busy ranch manager’s schedule, therefore, to make these 

conservation goals more accessible to more ranchers, measuring and 

predicting phenology to inform prescribed grazing practices will need to be 

data-informed, adaptive, and streamlined. Conservationists and agricultural 

producers will need to collaborate to develop practical means of restoring, 
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managing, and monitoring working lands to assess progress into the future to ensure that we maintain a 

more sustainable balance between the tenants of the triple bottom line: People, Planet, Prosperity (UN 

2015). To help ranchers obtain this information without adding extensive labor to their busy schedules, we 

PHENOLOGY:

the study of cyclic and 
seasonal natural phenomena, 
especially in relation to 
climate, plant and animal life

aim to conduct a pilot study on several North Texas ranches in the 

spring-summer of 2022 to test novel remote imaging technology and 

community science protocols to measure the phenology of prairie species so 

ranchers can better time their prescribed grazing practices for the conservation 

of native plant and pollinator species. 



Objectives

Regenerative ranching practitioners are balancing many factors daily 
as a part of their livestock and landscape management goals: 
weather and seasonality, business and economics, animal health and 
diet, plant and forage resources, among others. Traditionally it has 
been believed that these goals are in opposition to the goals of 
conservationists, who ideally are working to restore as many 
ecosystems to their ecological climax communities and conserve as 
much biological diversity as possible. For this project we aimed to 
follow the tenets of the Radical Center, which posits that ranchers 

OBJECTIVE 1: 

Establish a system of phenological 
observation cameras in pastures at 
several North Texas ranches practicing 
prescribed grazing to collect phenology 
data of Fort Worth Prairie species.

OBJECTIVE 2: 

Collect accompanying pollinator 
community data during the phenological 
observation period to model targeted 
species-specific conservation practices 
on working lands.

OBJECTIVE 4: 

Develop a community science campaign 
to engage the public in phenological 
data tracking to amplify the data 
collection capacities of conservationists 
and ranchers.

OBJECTIVE 5: 

Practice collaborative conservation 
approaches to develop resources and 
management recommendations. 
Disseminate these practices to new 
audiences and expand our network.

OBJECTIVE 3: 

Practice simple ecological monitoring 
protocols to aid regenerative ranchers in 
assessing their progress and combine 
contemporary and historic data to 
inform conservation tools.
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and environmentalists can and should be working toward the common goal of appropriate use and 
management of the land to balance ecology and economics (Quivira Coalition 2020). Through a collaborative 
and community-engaged approach to collecting ecological monitoring data, we aim to pilot methods and 
protocols for engaging ranchers and communities in collecting phenological data in prairie plant communities 
that are actively being grazed on working ranches. We aim to refine ecological monitoring on regenerative 
ranches and foster the adoption of regenerative practices through the following 6 objectives:

OBJECTIVE 6: 

Present and share data and resources 
used to compile and developed from this 
project in publicly accessible, open 
source, and engaging formats for a 
variety of audiences and shareholders.



All data from this project is publicly available through our online data dashboard.

Study System

To pursue the 6 aforementioned objectives, we established a study system 
composed of a network of 4 ranches in and around the Dallas-Fort Worth 
metroplex, specifically ranches that are located within the Fort Worth Prairie 
ecoregion (see map below or on google). With the generous collaboration of our 
participating ranches (the Dixon Water Foundation and G Bar C ranch to the North 
near Era and Rosston, TX, Burgundy Pasture Beef at C7 ranch to the South near 
Grandview, TX, and Cougar Hollow ranch to the Southeast near Lipan, TX) we installed 
10 weatherproof, solar-powered, Tikee 3 long-term timelapse cameras in 10 
pastures (4 @DWF, 2 @GBC, 2 @C7, 2 @CH) where regenerative, rest-rotation 
grazing is practiced. At three of these ranches that did not previously have 
weather stations (GBC, C7, CH), Columbia Capricorn FLX weather stations 
provided by Texas Christian University’s Ranch Management Program (Columbia 
Weather Stations).

The Fort Worth Prairie is a vegetative sub-region nested between the East and 
West Cross Timbers that extends into Cooke, Montague, Denton, Wise, Tarrant, 
Parker, Johnson, and Hood counties. It is composed largely of treeless 
vegetative assemblages with gently sloping topography and ”cuesta“ 
escarpments derived from the thin soil that covers hard layers of limestone. 
North American tallgrass prairies once covered this region, but today these 
habitats have mostly been degraded, with only remnants remaining (TPWD 
2005). Home to hundreds of native species, the Fort Worth Prairie and 
surrounding tallgrass prairies also act as important parts of the North American 
Central Flyway for migratory birds and insects such as Monarch Butterflies and 
several species of warblers (Audubon & Journey North 2023).
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LAND ACKNOWLEDGEMENT: 

The Fort Worth Prairie is the ancestral homelands 
of the Wichita, Kickapoo, and Comanche peoples 
for whom American bison were an important 
cultural staple. Selective grazing by bison and 
wildfires historically maintained prairie ecosystem 
health in the central United States. Settlers 
over-hunted bison, inhibiting the ability of these 
tribes to sustain themselves on the land and 
permanently altering the ecology of these 
ecosystems (Native Land Digital 2023).

OBJECTIVE 1: 

Establish a system of 
phenological observation 
cameras in pastures at several 
North Texas ranches practicing 
prescribed grazing to collect 
phenology data of Fort Worth 
Prairie species.

https://lookerstudio.google.com/reporting/c3d32bb7-7316-4ae7-a069-ec629cb91902
https://goo.gl/maps/HdPMANiv6DTnB1ea8


● The field study portion of this project took place between 
March and September 2022 during the spring and 
summer flowering seasons in North Texas. 

● Solar-powered, long-term Tikee 3 timelapse cameras 
(see page 18 for more information) were placed facing 
North or South in pastures selected by participating 
ranchers due to their interest in seeing temporal change 
in the plant communities in these pastures.

● Cameras were staked into the soil behind cattle guards 
at approximately 6 feet off the ground to prevent cattle 
interference with the cameras.

● The Tikee 3 cameras were programmed to take and 
upload 1-3 daily 220° stitched images to cloud data 
storage on the myTikee interface via cellular networks 
(cameras are equipped with SIM cards) where they were 
downloaded and shared via google drive with team 
members and participating ranchers: Phenology Field 
Photo Share 

● Protocol were developed to collect floral species count 
data from these images over the fall of 2022 (see Data 
Analysis Methods on Page 8). 

● Accompanying pollinator community data was collected 
once per month from May to September at 2 cameras 
per ranch along six 50 m transects radiating from each 
phenological camera as a focal point (see figure below). 

● Pollinators were collected opportunistically along 
transects and using sweep netting methods identified 
as the most effective method for collecting the highest 
diversity of native pollinators (Prendergast et al. 2020).

● For the sake of this study, ”pollinators“ were considered 
any floral visitor observed along the designated 
transects - species of insects seen on a flower, landing 
on a flower, or departing from a flower.

● Upon capture, pollinators were stored in labeled 1.5 mL 
tubes and placed in a -20° freezer upon return from 
the field each day.

● In August 2022, pollinators were vortexed in 70% 
ethanol to remove all pollen from their bodies, then 
were pinned for identification and pollen slides were 
made using fuschian jelly stain (as per Kearns & Inouye 
1993). 

● In the fall of 2022, pollinators were identified to family, 
genus or species by M. O’Connell. 

● Pollen preferences of our pollinators will be analyzed 
from the pollen slides at a later date.

Field Methods
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OBJECTIVE 3: 

Practice simple ecological monitoring protocols 
to aid regenerative ranchers in assessing their 
progress and combine contemporary and 
historic data to inform conservation tools.

OBJECTIVE 2: 

Collect accompanying pollinator community 
data during the phenological observation 
period to model targeted species-specific 
conservation practices on working lands.

https://drive.google.com/drive/folders/149gnPasQnDmCE37ZgDwu3QM_jg7G0DIF?usp=share_link
https://drive.google.com/drive/folders/149gnPasQnDmCE37ZgDwu3QM_jg7G0DIF?usp=share_link


Data Analysis Methods

The data collection goals of this project are multifold: we aim to use our digital data 
collection methods as an opportunity to engage more people, beyond the scientific 
and agricultural communities, in understanding these issues and participating in the 
creation of conservation solutions (Gonsalves 2005). By crowdsourcing data 
processing, we can provide information to ranchers faster, while engaging the 
public in important conversations about climate change, agriculture, and 
conservation. To do this, we are engaging in a multiphase data analysis program 
that engages education researchers to develop a community science protocol that 
will produce quality ecological data. The data needs for this project are also 
multifold in that we aim to combine historic records with contemporary 
observations to better inform conservation tools that we can apply in rotational 
ranching operations (see research scheme below). As we have worked on year 1 
of this project, we have maintained an adaptive approach that has helped us 
determine the following necessary phases for the creation of a community science 
program that creates real results:

1. Expert analysis of phenological camera image: initially we intended to have 
community scientists analyze images from our cameras but realized that data 
collection from the images was more complex than expected, so we developed a 
protocol for analyzing these images and research team members refined the 
protocol to determine if it can be translated into a community science protocol (see 
page 9).   

2. Expert analysis of pollinator communities: After identification, our team 
quantified pollinator community diversity (H), species abundance and richness, and 
each pasture’s potential max diversity ratio (HMax). In future years of this project, we 
aim to combine this information with historic records from the region to assess 
long-term shifts in pollinator presence on the landscape. 

3. Community scientist analysis of historical records: We worked with 
educational researchers from TCU to pilot a community science program that 
engaged non-science major undergraduates in helping collect phenological  

  8  .

OBJECTIVE 4: 

Develop a community science 
campaign to engage the public in 
phenological data tracking to 
amplify the data collection 
capacities of conservationists and 
ranchers.

information from historic botanical records from the BRIT 
herbarium. Additionally, TCU researcher’s developed an 
educational research scheme to understand how participatory 
research influences student perspectives on conservation and 
regenerative agriculture (see page 16).

4.  Expert data synthesis: Using this year 1 data and future 
iterations of this project, we will synthesize historic and 
contemporary phenological observations with meteorological 
data from our weather stations, and pollinator observations to 
produce the suite of outcomes listed in our research scheme: 
ecological analyses, long-term, community level phenological 
records, community science campaigns and modules, as well 
as publicly accessible land management and conservation 
tools.

OBJECTIVE 3: 

Practice simple ecological 
monitoring protocols to aid 
regenerative ranchers in assessing 
their progress and combine 
contemporary and historic data to 
inform conservation tools.



ImageJ Download and install.
● Download ImageJ:

https://imagej.nih.gov/ij/download.html
● Download cell_counter.jar plugin: 

https://imagej.nih.gov/ij/plugins/cell-counter.html
● Add cell_counter.jar plugin to ImageJ folder.
● Restart ImageJ.

Before starting the analysis.
● We subsampled 12 squares per image in which we 

quantified floral species richness
● To select random squares, go to: 

https://randomnumbergenerator.org/ 
● Do not repeat; Numbers: 12; From: 1 To: 36

Analyze images.
● Open ImageJ
● File > Open > select picture
● Analyze > Tools > Grid

Area per point: 80,000 pixels/squares > [OK]
● Plugins > Cell Counter > Cell Counter window opens: 

Click [Initialize]
Click [Add] until you have 30+ types.
Start scrolling for the selected squares

● Count each flower type in each grid square.
● If you aren’t sure of a species you’re seeing - refer to our 

floral guide: 
https://docs.google.com/presentation/d/1qCHqPeUBs
bpECc2XqlIa6EDSL3p4_HPZ/edit#slide=id.p1 

● Count the number of individuals of each species
in all 12 squares without resetting the cell counter

Saving results:
● Click [Results] > Copy/paste 

to excel
Saving Markers:

● On Cell Counter click 
[Save Markers]
Output name will be like: 
CellCounter_2022-05-05-14-30-
00-001

● Delete Cell Counter
The file name should be: 
2022-05-05-14-30-00-001.xml

Saving images:
● File > Save As > .Jpeg

Output name will be like: 
Counter Window - 2022-05-05-14-30-00-001

● Delete Counter Window  
The file name should be: 
2022-05-05-14-30-00-001.Jpeg

● Both .xml and .Jpeg files need to have the same name
If you want to edit an image [open an image again]:

● File > Open > 2022-05-05-14-30-00-001.Jpeg
Image opens with the grid.

● Plugins > Cell Counter > Cell Counter window opens
🚨Do not click [Initialize]

● Click [Load Markers] > 2022-05-05-14-30-00-001.xml
● [Add] the rest of the Types until 30+
● Reanalyze

Data Analysis Methods

31 32 33 34 35 36

23 24 25 26 27 28 29 30

13 14 15 16 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12
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https://imagej.nih.gov/ij/download.html
https://imagej.nih.gov/ij/plugins/cell-counter.html
https://randomnumbergenerator.org/
https://docs.google.com/presentation/d/1qCHqPeUBsbpECc2XqlIa6EDSL3p4_HPZ/edit#slide=id.p1
https://docs.google.com/presentation/d/1qCHqPeUBsbpECc2XqlIa6EDSL3p4_HPZ/edit#slide=id.p1


Phenology Results

Phenological data was collected and analyzed at the per pasture level. At the Dixon 
Water Foundation Leo Unit, phenological data were collected in 4 pastures: the 
Shortgrass, Pavilion, Oil Pad, and Lowland pastures (google map). As per the 
ImageJ floral counting protocol (page 9), the following phenological time series 
(ages 10-11) show the temporal presence and abundance (number of individual 
flowers observed) of each floral species in each pasture from ~March to 
~September of 2022. From these time series we were able to calculate floral 
abundance, species richness, diversity (Shannon-Weiner Index(H)), and the 
potential max diversity ratio (species diversity/potential max diversity (Hmax)). 

At the Dixon Water Foundation Leo Unit, we experienced a late spring start to 
blooming and did not detect floral species with our cameras until April. Overall, the 
Shortgrass pasture outperformed the other three pastures in regard to floral 
species richness and diversity in all studied months, likely due to the shallow, rocky 
soil conditions in the site (Loughmiller et al. 2018). Across all pastures, May by far 
was the most prolific month for floral abundance (>50% of all floral observations 
were made in May), species richness and diversity, but this may have been due in 
part to the late start to the season, delaying first blooms for several species. 
Although the Shortgrass pasture harbored a greater species diversity in most 
months, in regard to species diversity compared to the maximum diversity each 
pasture could potentially host, other pastures such as Oil Pad, in April and June 
were hosting similar Hmax ratios to the Shortgrass pasture, with both pastures in 
2022 harboring around 60% of their potential maximum diversity, potentially 
showing substantive restoration progress. 

26 

forb species observed 
1,581 

individual flowers detected

Floral abundance by Month

Floral Species Richness

Floral 
Species 

Diversity (H)

Potential 
Max Species 

Diversity 
Ratio (Hmax)
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https://goo.gl/maps/HdPMANiv6DTnB1ea8


Phenology Results
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Gaillardia sp. 144 Grindelia sp. 9

Indet. 1 89 Indet. 3 8

Thelesperma sp. 54 Pyrrhopappus sp. 7

Asclepias sp. 50 Monarda sp. 6

Oenothera sp. 2 49 Linum sp. 5

Torilis sp. 38 Convolvulus sp. 5

Callirhoe sp. 28 Glandularia sp. 4

Linheimera sp. 24 Indet. 2 1

Ranunculus sp. 17

Oenothera sp. 1 9

Shortgrass

Pavilion

Torilis sp. 244 Berlandera sp. 3

Centaurea sp. 102 Pyrrhopappus sp. 1

Tetraneuris sp. 51 Oenothera sp. 1

Erigeron sp. 26 Solanum sp. 1

Ranunculus sp. 12

Indet. 1 11

Convolvulus sp. 10

Asclepias sp. 3

INTERPRETATION: Important genera such as Oenothera (Yellow Sundrops), Ranunculus (Hairy buttercup), Callirhoe (Winecup), 
and Asclepias (Green/Antelope Horn Milkweeds), all having been reported as important bee (Glenny et al. 2022), moth and butterfly 
(LBJWFC), and specifically monarch butterfly (Brym et al. 2018) resource plants, were present and dominant in this pasture early in 
the season, making this an important early season pollinator habitat during from late March to early May. As these species 
began setting seed, the pasture became dominated by other popular pollinator genera such as Gaillardia (Blanketflower), 
Thelesperma (Stiff Greenthread), and Monarda (Beebalm) from late April to late May. This pasture becomes significantly less diverse 
beginning in June, with Oenothera (Evening Primrose) and Grindelia (Gumweed) being the only floral secis captured by our camera.

INTERPRETATION: A less florally diverse pasture than Shortgrass, we observed the Pavilion to be more dominated by tall grass 
species that have the potential to outcompete and shade out low-growing herbs. In this pasture, flowering largely occurred between 
the mid-April to late June and was dominated by Torilis (Wild Carrot), Erigeron (Fleabane), Tetraneuris (Bitterweed), and Centaurea 
(American Basket-flower). Of these species, Centaurea is of particular conservation important from Mid-May to late June as a 
generous nectar supplier for butterflies as well as a seed source for dove and quail, making this pasture most important from 
mid-may to late June (Pollinator Partnership).



Phenology Results
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Oil Pad

Lowland

Oenothera sp. 440

Solanum sp. 9

Ranunculus sp. 37 Convolvulus sp. 3

Thelesperma sp. 15 Indet. 1 2

Indet. 2 13 Achillea sp. 1

Solanum sp. 12 Oenothera sp. 1

Centaurea sp. 9 Pyrrhopappus sp. 1

Linheimera sp. 8 Eryngium sp. 1

Torilis sp. 8 Callirhoe sp. 1

Berlandiera sp. 8

INTERPRETATION: The Lowland pasture displayed the lowest diversity of floral species throughout the season and we only 
detected a significant Evening Primrose bloom from late March to June. This species, among the present grasses, was the dominant 
floral species, likely because of the wet soil conditions at this site, which are unfavorable for many prairie forb species (Loughmiller 
et al. 2018). Although Oenothera speciosa has been cited as being a resource to a variety of species from specialized bees, to hawk 
moths, to providing seeds to birds and small mammals, it has also been reported as not an ideal species to support pollinators, as it 
sometimes can become too dominant in native prairies, crowding out rarer native species due to its aggressive growth habits 
(LBJWFC). 

INTERPRETATION: Surprisingly, the Oil Pad pasture, despite its management history, had the second highest floral diversity 
detected by our cameras and was the only pasture to have a significant post-summer bloom period. Like the two previously 
discussed pastures, the main bloom event from May to late June was dominated by Stiff Greenthread and American Basket-Flower, 
but we also detected a higher presence of “weedy” genera like Solanum (Silverleaf Nightshade) and Convolvulus (Texas Bindweed), 
which are indicators of highly disturbed and/or lower quality habitat (Texas Invasive Species Institute). Importantly, this pasture 
showed the greatest diversity, of those studied, during the month of September when we detected a significant bloom of 
Ranunculus (Hairy buttercup) and Lindheimera (Texas Yellow-star), both helpful pollinator resources.  



Floral Guide
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All data from this project is publicly available through our 
online data dashboard.

https://lookerstudio.google.com/reporting/c3d32bb7-7316-4ae7-a069-ec629cb91902


Pollinator Results

Pollinator data was collected and analyzed at the per pasture level at Dixon Water 
Foundation Leo Unit’s Shortgrass and Pavilion pastures (google map). As per the 
aforementioned pollinator transect protocol (page 7), four collection periods from May 
to September of 2022 yielded observations of 38 different pollinator species and a 
total of 73 individuals that were collected and identified largely to family/genus and 
some to species. From these specimens, we were able to calculate pollinator 
abundance, species richness, diversity (Shannon-Weiner Index(H)), and the potential 
max diversity ratio (species diversity/potential max diversity (Hmax)). 

At the Dixon Water Foundation Leo Unit, due to the late spring and hiring a field 
crew member, we were not able to do sufficient pollinator collections until May, 
therefore pollinator data from March and April have not been included. Overall, the 
most pollinators were collected during June (~39%), despite this not being the month 
with the highest floral abundance and diversity. While the Shortgrass pasture 
supported more pollinators in May and August, the Pavilion pasture hosted a 
significantly higher diversity of species in June and more importantly in July, when 
floral species diversity was at its lowest and we were only able to collect one 
pollinator at Shortgrass. Importantly, it should be noted that in July and August both 
pastures had incredibly low floral species diversity, with both pastures largely hosting 
a single floral species during that observation period: Euphorbia bicolor (Snow on the 
Prairie) at Shortgrass and Stenosiphon linifolius (False Gaura) at Pavilion, both of 
which were undetected by our cameras. Lastly, depending on the month, both 
pastures hosted a pollinator community approaching 75% the potential max species 
diversity indicating that when floral resources are more abundant (in May and June) 
these pastures are well on their way to supporting healthy pollinator communities, but 
in July and August pollinators will require much more substantive floral resources to 
continue utilizing these pastures as habitat. 

38

pollinator species observed 
73 

individuals collected

Pollinator abundance by Month

Pollinator Abundance by Month/Order

Pollinator 
Species 

Diversity (H)

Potential 
Max Species 

Diversity 
Ratio (Hmax)

  14  .

https://goo.gl/maps/HdPMANiv6DTnB1ea8


Caveats, Future Directions, and New Questions:

➢ These observations were only made during 1 study year, therefore we need to perform 
additional years of observations and combine these data with historic records to surmise 
long-term trends.

○We will continue to develop a methods paper for this project and aim to pursue future 
funding to potentially pursue this continued work on participating ranches and additional 
ranches, so we can produce ecological publications and interactive online resources).

➢ Cameras need to be laced closer to the ground to get finer data resolution - we had 
issues balancing image quality and accuracy of some plant ID’s - particularly in the 
several species of yellow flowers we had in this project.

➢ Pollinators are indicator species, they tell us about the quality of the habitat we are 
managing, therefore we want to pursue future collaborative questions like:

○How do we make pollinator conservation a normal part of rotational grazing cycles? 
○If we aim for conserving pollinators, what other wildlife species may benefit?
○Are these practical goals on all ranches or just some?

➢ Continued collaborative conversations with our participating ranchers will help us 
understand how to develop more feasible recommendations. 

Recommendations
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OBJECTIVE 5: 

Practice collaborative conservation 
approaches to develop resources and 
management recommendations. 
Disseminate these practices to new 
audiences and expand our network.

March to May: 

Potentially avoid grazing 
the Shortgrass pasture to 
protect important floral 

resources for early 
season native bees and 

monarch butterflies 
spring migration.

Late May to June: 

Potentially avoid grazing 
the Pavilion pasture as 

this period of time 
supports the highest 
observed diversity of 

pollinators in this 
pasture.

DISCLAIMER: All recommendations here are made taking pollinators into consideration but are not meant to be 
prescriptive. We are aware that sometimes these recommendations may come into conflict with other needs on the 
ranch, therefore we acknowledge that these suggestions are helpful in understanding where pollinators are present on 
the ranch and when, but that collaborative conversations among project stakeholders will help us better understand 
how feasible these recommendations will be at the Dixon Water Foundation and beyond. Additionally, we would like to 
acknowledge that these observations were only made over 1 study year, therefore additional years of data will be 
needed to codify these recommendations. Potential future recommendations could look like the following:

July to August: 

All pastures, except  
Pavilion in July and 

Shortgrass in August are 
potentially suitable for 

grazing with possible low 
impact on pollinators. 

Potential to support more 
pollinators with additional 

seeding of appropriate 
floral species.

September (Fall): 

Potentially avoid grazing 
the Oil Pad pasture to 

protect floral resources 
while pollinators are 

resource stressed after low 
resource months of July 

and August.

➢ What parts of this project were vital and which parts are impractical 
or can be left behind?

➢ Are there more effective alternative approaches to collecting the 
same data? 

➢ How can we engage more producers in these conversations and in 
utilizing future resources we may develop?

➢ Camera and weather station management: partners to discuss future 
management plan for continued camera functioning and weather 
station cellular service.



In the fall of 2022, with the collaboration of TCU’s Andrews 
Institute for Research in Math & Science Education and Institute 
for Ranch Management we set about developing a community 
science pilot program to address our need to quantify historical 
phenological data. Through this pilot our aims were two-fold: to 
crowdsource the collect historical phenological data from BRIT 
herbarium specimens, and to study how participatory community 
science research models shift public perceptions of conservation 
and regenerative agriculture (Wandersman 2003). 

In a semester-long undergraduate course for non-science 
majors, Challenges of Global Food Production & Distribution, 
students engaged in a series of surveys, lectures, and activities 
related to our project. Using the Zooniverse platform, we shared 
images of historic specimens of selected species known to grow 
in the Fort Worth Prairie from which students helped us assess 
their phenology digitally. The digitization of information from 
phenological records is time consuming, therefore the task of 
digitizing when a specimen was collected and whether it was in 
flower or fruit is a simple task to crowdsource and use as a public 
engagement opportunity. Thus far we have had a total of 30 
students help score >1200 historic records and had 10 of these 
students participate in the first pilot round of our education 
research study to assess the impact of their participation in the 
project.

Non-science majors reported increases in their belief that 
they personally can help solve environmental issues and a 
shift toward a better understanding of the 
interconnectedness of the environment, agriculture, and an 
individual’s actions. This pilot will continue next fall to 
incorporate more students in a variety of courses so we can 
refine our community science protocols to incorporate broader 
audiences, such as the network of ranch-owning alumni from the 
Institute of Ranch Management and public high school classes, 
and develop publications regarding the impacts of our community 
science work.

Community Science
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OBJECTIVE 4: 

Develop a community science campaign 
to engage the public in phenological 
data tracking to amplify the data 
collection capacities of conservationists 
and ranchers.

OBJECTIVE 6: 

Present and share data and resources 
used to compile and developed from this 
project in publicly accessible, open 
source, and engaging formats for a 
variety of audiences and shareholders.

OBJECTIVE 3: 

Practice simple ecological monitoring 
protocols to aid regenerative ranchers in 
assessing their progress and combine 
contemporary and historic data to 
inform conservation tools.

https://fwbg.org/research/herbarium/
https://fwbg.org/research/herbarium/
https://www.zooniverse.org/
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Enlaps Tikee 3 Camera
● 100% self-sufficient – solar panel and battery
● 100% connected– Wifi & 4G
● Weatherproof & designed for outdoor use
● Compact – 21 x 18 x 7 cm – 1,5 kg
● Photos: 4K & 220° panoramic

The cameras used to collect phenological images for this 
project were 10 Tikee 3 timelapse cameras from Enlaps, 
a French startup offering long-term timelapse cameras 
that combine hardware and software to capture images 
remotely that are managed through their online SaaS 
platform: myTikee. 
    The Tikee 3 camera is operated through a proprietary 
app, Tikee Remote, on the user’s cell phone via a 
bluetooth connection and is fairly straightforward to 
operate, although occasionally has issues connecting to 
the cameras; sometimes we had to restart the app 
several times to get it to connect properly to cameras. 
Through the app, the cameras can be programmed to 
turn on/off and take a series of long-term timelapse 
images at various personalized intervals and can also be 
programmed to take videos, and upload these images to 
cloud storage. Cloud storage capacities are only 
accessible if the user purchases SIM cards and pays for 
data plans that connect to cellular networks with local 
service in the area. Images on these cameras are taken 
with two 4k cameras and can be stored on in-camera 
SD cards (~$15/card) as two separate images the user 
will need to stitch together manually, but images 
uploaded to cloud storage are automatically stitched 
together via the myTikee software and are stored on the 
myTikee platform. 

All images uploaded to cloud storage can only be 
accessed through the myTikee software, but can be 
downloaded from this site and utilized for analyses on the 
user’s IOS, although even the ”high quality“ 
stitched/uploaded images appear to have reduced quality 
compared to the images stored on the SD card. The 
myTikee platform also allows the user to process 
rudimentary timelapse videos from their images and track 
camera battery levels, cellular connectivity, and most 
recent image upload to inform users if any of their cameras 
have gone offline and need attention.  
    While the cameras are fairly cost-effective for their 
capacities, hardiness, and reliability, there are other 
associated costs to operating this equipment that users 
should be aware of before employing Enlaps equipment. To 
access the myTikee platform, users can use very 
rudimentary camera management and image processing 
functions on the platform for free, but if they’d like to need 
to pay for a software subscription that can range from 
$200 for 3 months of access to $500 for 12 months of 
access. Additionally, we found affordable SIM cards and 
data plans through IoT SIM cards that connect to nearby 
cellular networks (i.e. AT&T and T-Mobile) that users can 
affordably pay for smaller quantities of data (i.e. $36 for 
2.5 GB over 6-12 months which generously covered our 
per camera upload needs for this project). Lastly, 
equipment insurance is needed to ensure that these 
cameras can be replaced if any circumstances come up in 
the field, for example we had one camera infested with fire 
ants that ate the electrical wiring and rendered the camera 
inoperable. Due to the nature of equipment, the policy 
recommended to us was called an inland marine policy and 
we chose to receive coverage from an insurance provider 
called CoverWallet that insured all 10 cameras for 
$650/year (all cameras are currently insured through the 
end of 2023).

Camera Management
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https://enlaps.io/us/tikee3.html?gclid=CjwKCAjw_YShBhAiEiwAMomsEHBjQn8Xgk4PSJapQSUvwauMoyFAxEmiuGVVeZskZjjYlG5rG3WubRoCn2gQAvD_BwE
https://my.tikee.io/
https://enlaps.io/ww/en/tikee-remote-app-mobile-timelapse
https://www.amazon.com/gp/product/B096X8471C/ref=ppx_yo_dt_b_asin_title_o02_s00?ie=UTF8&psc=1
https://www.coverwallet.com/?&geo=1&utm_source=google&utm_medium=cpc&utm_campaign=us_brand&utm_content=us_brand_exact&utm_term=coverwallet&gclid=CjwKCAjw_YShBhAiEiwAMomsEO07RozkdVIxSwzuaFuKUumEeoRaUOx6CbC0oaLJR-U9C9ZjJ8rBMBoCy4MQAvD_BwE


Tikee Remote App User Guide:

1. Download the Tikee Remote app from your app store.
2. On the back of the camera you would like to set up, 

press the power button in until the power light flashes 
blue.

3. Make sure your bluetooth is on on your cell phone, then 
open the Tikee Remote app and tap the blue circle to 
scan for nearby cameras. If the camera is properly 
turned on it will appear at the bottom of your screen as 
in panel 1 above.

4. You will then be connected to your camera’s interface 
where you can check the cameras battery level, cellular 
connectivity, the last time it uploaded an image, and 
whether it has a timelapse running currently (panel 2 
above).

5. To set up a timelapse, look down under your timelpases 
as in panel 2 above and click on the current timelapse or 
set up a timelapse.

6.  As in panel 3 above, you will see options to edit your 
timelapse: you can name it, decide if you are running an 
infinite long-term timelapse or only want to take images for 
a certain period of time. You can set the window of time 
each day you want the camera to take pictures, how 
much time you want between each picture, and what days 
of the week you would like it to take pictures.

7.  In  panel 4 you see that you will have options to control 
the image format, quality, and whether it both uploads and 
saves images to the in camera SD card.

8.  Press start timelapse. You will know the camera is 
successfully taking images if you go onto the myTikee 
software on your computer and find an uploaded image.

9.  NOTE: You will want to make sure that the upload rate is 
set to daily uploads if you want to see new images online 
daily. To do this you will need to go to the upload settings 
(found in panel 2) and set the upload threshold to 1 image. 
This way the camera will upload each image as it is taken. 
Depending on the cellular service in your area this could 
take 2-24 hours.

Camera Management
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